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Be sure to check out our new Blogs and discover all the new Free Training!
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Subscribe instructions are at the end.
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and associates who might be interested!
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1)... Editor's Greeting 

2)... Best New Free Microsoft Office Training & Tutorial Sites 

3)... The Best New Free Training Sites for Flash, Photoshop, Dreamweaver, 
FrontPage, & other Adobe / Macromedia Applications 

4)... Best New Free Web Development Training Sites 

5)... Best New Free Windows, Linux, Hardware & Computer Training 

6)... Software, Office and Computer Sites Worth Mentioning 

7)... Question of the Month about Software Training 

8)... Please Support Our Computer Training Mission 

  

1) Editor's Greeting:

Hello everyone, and welcome to our new subscribers! 

Here is our July 2008 issue (#51) of our Free monthly Newsletter for 
EducationOnlineForComputers.com, giving you the most current Free online 
Microsoft Office and Web Development Software Training and Tutorial Resources 
that we have recently discovered and researched. This newsletter is free to anyone 
subscribing (instructions at bottom, no username/password is needed). To access 
our member site, however, you do need a user name and password - registering as 
a member of EducationOnlineForComputers.com costs only $14 for two months, for 
more information please see Become a Member of 
EducationOnlineForComputers.com. 

My desire is that these free resources will help you with your computer education 
and training and will help you advance your career. Our main mission is the training 
of those less fortunate who are seeking to become computer literate, from a user's 
perspective. 
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By means of this email newsletter, you have knowledge of and access to these sites 
before our web site visitors do. The best of these resources will be added to our 
Member Training pages and the remainder to our Free Training pages. 

*** Current Issue *** 

In this issue we are featuring a total of 43 Computer Software Application training, 
learning and tutorial web sites, with a total of 172 tutorial courses linked. It features 
many Free Microsoft Office, Flash, Photoshop, Dreamweaver, and Web 
Development training tutorials for your learning profit and enjoyment.  

Please take a look at and bookmark our Blogs, these will be updated daily and 
weekly with New Free Training and Tutorial Resources, as I discover and 
evaluate them:

EducationOnlineForComputers.com Blogs:

       - Free Microsoft Office Training

       - Free Web Development Training

       - Free Adobe & Macromedia Training

Intelligentedu.com Blogs:

       - Free Technical Computer Training

       - Free Computer Books & Ebooks

To get your Free MS Office and Web Development Software Training updates 
via RSS, please copy (right click and copy shortcut or link location) and paste these 
urls into your RSS reader:

Free_Microsoft_Office_Training_Tutorial_Resources_rss2.xml
Free_Training_Photoshop_Flash_Dreamweaver_FrontPage_Adobe_Macromedia_rss2.xml
Free_Web_Development_Training_Tutorial_Resources_rss2.xml
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If you are looking for free technical or programming training, please visit our sister 
site: 
http://www.intelligentedu.com. 

Also, please check out our new free computer training search site at 
www.edcomp.com.

I wish you the best with your computer studies and learning. 

Warm Regards, 
Scott Turton Newsletter and Web Site Editor
scott_turton@EducationOnlineForComputers.com
http://www.EducationOnlineForComputers.com 

  

"Learn New Skills and Increase Your Earning Power
 - With Free Online Computer Training!"

*** Become a Member of EducationOnlineForComputers.com ***  

Our Members' Site contains the web's best Microsoft Office and other software 
training resources and tutorials. This content is individually linked and presented in a 
way to expedite and facilitate your computer learning experience. We have done all 
the web research and presentation work for you so you can concentrate solely on 
your computer training. For short FAQ Answers, please see the end of this 
newsletter. 

The total price to join as a member is only $14 total for 2 months, $24 for 4 months, 
$32 for 6 months, or $56 for a whole year. The funds generated will assist us to help 
all those seeking computer education and application end-user training. Here's the 
link to see what's available on our member's site and to sign up. 
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EdComp.com:
http://www.edcomp.com/

This is our new free computer and IT education and training search engine housing 
over 140,000 free training internet resources! Just type in a topic you're looking for 
and get tons of great web resources instantly. These search results are much better 
than the big search engines, like google. You can also check out our predefined 
search results page giving you tons of free training resources: 
http://www.edcomp.com/predefined.htm. 

  

--> Here is Your Reward for Subscribing to this Newsletter <-- 

*** Get Your Free Microsoft Office Forms and Templates ***

Click here for tons of Free Office Forms and Templates 

 

 

2) The Best New Free Microsoft Office Training & Tutorial 
Sites: 

This section of our newsletter contains the best new Free Microsoft Office training 
and tutorial sites that we have found and researched in the last few weeks.  

 

TrainingByEmail

Visit TrainingByEmail to receive Free Training for Word, Excel, Outlook, C#, 
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ASP.Net, and SQL via your email every week! We will send out a new training in the 
topic of your choosing every week. You can then save this, print it out, or delete it all 
at your convenience. And you can't beat the price, FREE! 

 

Free Courseware for Microsoft Office

Rai OpenCourseware offers freely available course content, or courseware, which is 
literally a "treasure trove of knowledge and related resources".  Their Computing 
Courses provide higher education and learning for Information Technology to all 
students and professionals who like to study and learn on their own. Educational 
institutions can also use this free course content.

Here is Rai OpenCourseware's Microsoft Office Training, that will teach you several 
important features of using Word, PowerPoint, Excel, and Access. These free Office 
training modules are well illustrated and provide step-by-step instructions for using 
these applications. The course modules are in pdf format and are also available 
here, here, and here.

Basic Concepts Of Computers 
 - Computer Organisation 
 - Operating System 
 - Microsoft Office Overview 
 - Introduction Word Processing 

Getting Started With Microsot Word 
 - Formatting Paragraphs 
 - Styles 
 - Tables 
 - Macros 
 - Mail Merge 

Introduction To Microsoft PowerPoint 
 - Adding Content 
 - Color Scheme 
 - Master Slides 
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Introduction To Microsoft Excel 
 - Formulas and functions 
 - Charts 
 - Paper properties and printing 

Microsoft Access 
 - Table Relationships 
 - Queries 
 - Forms 
 - Reports 
 - Importing, Exporting, Linking 

 

60 Free Word 2007 Tutorial Videos

Here are 60 Free Word 2007 Tutorial Videos (in Flash  format) from 
Officesessions.com. These are excellent training modules for learning these features 
and tasks in Word 2007, including editing the fonts, creating a chart, adding clipart, 
creating headers and footers, home tab, insert tab, mailing tab, paragraph 
alignment, updating themes, using the thesaurus, add comments, tracking changes, 
adding graphics, creating tables, updating the style, performing a spell check, 
encrypting a document, creating bookmarks, make columns, and using watermarks.

Word 2007 Video Tutorials:

1. About the Add-Ins Tab 
2. How to Change the Background Color 
3. How to Make Font Bold 
4. How to Change the Font 
5. How to Change the Font Size 
6. How to Create a Chart 
7. How to Add Clipart 
8. How to Change The Text Color 
9. How to Create a Document Compatible with Microsoft Word 97-2003 
10. How to Copy Text 

file:///C|/Data/newsletter51.html (7 of 34) [8/25/2008 10:32:05 PM]

http://www.rocw.raifoundation.org/computing/BCA/ms-office/lecture-notes/lecture-16.pdf
http://www.rocw.raifoundation.org/computing/BCA/ms-office/lecture-notes/lecture-17.pdf
http://www.rocw.raifoundation.org/computing/BCA/ms-office/lecture-notes/lecture-18.pdf
http://www.rocw.raifoundation.org/computing/BCA/ms-office/lecture-notes/lecture-19.pdf
http://www.rocw.raifoundation.org/computing/BCA/ms-office/lecture-notes/lecture-20.pdf
http://www.rocw.raifoundation.org/computing/BCA/ms-office/lecture-notes/lecture-21.pdf
http://www.rocw.raifoundation.org/computing/BCA/ms-office/lecture-notes/lecture-22.pdf
http://www.rocw.raifoundation.org/computing/BCA/ms-office/lecture-notes/lecture-23.pdf
http://www.rocw.raifoundation.org/computing/BCA/ms-office/lecture-notes/lecture-24.pdf
http://www.rocw.raifoundation.org/computing/BCA/ms-office/lecture-notes/lecture-25.pdf
http://www.educationonlineforcomputers.com/blogs/post/Free_Microsoft_Office_Training_Tutorial_Resources/948/60-Free-Word-2007-Tutorial-Videos
http://www.officesessions.com/word.php
http://www.officesessions.com/tutorials/word/addins.html
http://www.officesessions.com/tutorials/word/backroundcolor.html
http://www.officesessions.com/tutorials/word/bold.html
http://www.officesessions.com/tutorials/word/changefont.html
http://www.officesessions.com/tutorials/word/changefontsize.html
http://www.officesessions.com/tutorials/word/chart.html
http://www.officesessions.com/tutorials/word/clipart.html
http://www.officesessions.com/tutorials/word/colorchange.html
http://www.officesessions.com/tutorials/word/compad.html
http://www.officesessions.com/tutorials/word/copy.html


July 2008 Newsletter for EducationOnlineforComputers.com: Free Computer Software Training & Tutorials

11. How to Create a New Document 
12. How to Cut Text 
13. How to Create a Footer 
14. How to Create a Header 
15. About the Home Tab 
16. About the Insert Tab 
17. Intro to Microsoft Word 2007 
18. How to Put Words in Italics 
19. How to Left Justify, Right Justify, and Center 
20. About the Mailings Tab 
21. How to Insert Page Numbers 
22. How to Insert Text Boxes 
23. How to Change the Page Color 
24. How to Change Themes 
25. How to View the Word Count 
26. How to Use The Thesaurus 
27. How to Translate Text 
28. How to Add a Comment 
29. How to Track Changes 
30. How to Use the Research Function
31. How to Open a Document 
32. How to Change the Page Layout 
33. How to Paste Text 
34. How to Add a Picture 
35. How to Print a Document 
36. How to Do a Print Preview 
37. How to Do a Quick Print 
38. About the References Tab 
39. About the Review Tab 
40. How to Edit the Ribbon 
41. How to Save a Document 
42. How to Save a Document Compatible with Word 97-2007 
43. How to Do a Spell Check 
44. How to Change the Style 
45. How to Create a Table 
46. How to Save a Document as a Template 
47. How to Underline Text 
48. About the View Tab 
49. How to Zoom 
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50. How to Modify Word Properties 
51. How to Inspect a Document 
52. How to Mark a Document as Final 
53. How to Encrypt a Document 
54. How to Turn Marked as Final Off 
55. How to Create a Bookmark 
56. How to Go to a Bookmark 
57. How to Use Symbols 
58. How to Make Columns 
59. How to Change Orientation 
60. How to Use a Watermark 

 

Word Tips and Tutorials

Here are several Word Tips, Techniques and Tutorials, from 599cd.com. These 
learning pages will assist you in becoming a better and more effective Word user in 
the following areas: Mail Merge, Document Columns, Styles, Headers and Footers, 
Clipart, Tables, Date codes, and Images. 

Word Tips and Techniques:

How to use Mail Merge 
How to use Columns properly 
How to use Styles to format your document 
How to Cut, Copy, and Paste with Word 
How to make a Header and Footer 
How do I insert Clipart into my documents? 
Laying Out Your Page with Tables 
Inserting Automatic Date Codes in Word Documents 
Formatting a Section of your Document with Columns 
Inserting a Horizontal Line in your documents 
Stop Pictures Moving Around on the Page 
Making Word NOT automatically create hyperlinks 
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Changing Word's Startup Documents Folder 

Word Tutorial Articles:

Word: Different Headers & Footers
Word: Mail Merge Question
Free Word Mail Merge Video Tutorial 

 

78 Free Excel 2007 Tutorial Videos 

Here are 78 Free Excel 2007 Tutorial Videos (in Flash  format) from 
Officesessions.com. These are well done training tutorials for the following 
functionality in Excel 2007: Add-Ins Tab, Data Tab, Formulas Tab, Home Tab, Insert 
Tab, View Tab, Inspect and Encrypt the worksheet, Edit Fonts, Formta Cells, Find 
and Replace, Spell Check, Using the Thesaurus, Protect Sheets and Workbooks, 
Insert Pictures, Insert Clipart, Insert Shapes, Create Charts, Create Headers and 
Footers, Update the Theme, Display Sum of Cells, Change the Background, Undo 
and Redo, and the Quick Access Bar..

Excel 2007 Video Tutorials:

1.About the Add-Ins Tab 
2. About the Data Tab 
3. How to Delete a Cell 
4. How to Delete a Column 
5. How to Delete a Row 
6. About the Formulas Tab 
7. About the Home Tab 
8. About the Insert Tab 
9. How to Create a Document 
10. How to Open a Document 
11. About the Page Layout Tab 
12. How to Print a Document 
13. How to Use the Print Preview 
14. How to Use the Quick Print 
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15. About the Review Tab 
16. How to Save a Document 
17. How to Use the Save As 
18. How to Save as a Binary Document 
19. How to Save for Excel 97-2003 
20. How to Save as a Macro-Enabled 
21. About the View Tab 
22. Properties 
23. Inspect Document 
24. Encrypt Document 
25. Mark as Final 
26. Turn Mark as Final Off 
27. Run Compatibility Checker 
28. Change Font 
29. Change Font Size 
30. How to Put Text in Italics 
31. How to Bold Text 
32. How to Underline Text 
33. How to Change the Text Color 
34. How to Change the Cell Color 
35. How to Center, Left or Right Justify 
36. How to Change a Cell to Dollars 
37. How to Change a Cell to Other Currencies 
38. How to Put a Cell Into Percentage 
39. How to Increase Decimal Places 
40. How to Find Something On the Sheet 
41. How to Replace Found Text 
42. How to Use the Autosum Feature 
43. How to Cut Something 
44. How to Paste Something 
45. How to Use the Spell Check 
46. How to Use the Research Function 
47. How to Use the Thesaurus 
48. How to Use the Translate Function 
49. How to Protect a Sheet 
40. How to Create a Table 
51. How to Zoom In/Out 
52. How to Insert a Picture 
53. How to Insert Clipart 
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54. How to Insert Shapes 
55. How to Insert Smart Art 
56. How to Create a Column Chart 
57. How to Create a Line Chart 
58. How to Create a Pie Chart 
59. How to Create a Bar Chart 
60. How to Create a Scatter Chart 
61. How to Create a Area Chart 
62. How to Add Hyperlinks 
63. How to Insert a Text Box 
64. How to Create a Header 
65. How to Create a Footer 
66. How to Insert Word Art 
67. How to Insert a Object 
68. How to Decrease Decimal Places 
69. Into to Excel 
70. How to Copy Something 
71. How to Change the Theme 
72. How to Display Sum of Cells 
73. How to Change the Background 
74. How to Protect a Workbook 
75. How to Add a Sheet 
76. How to Use the Undo Function 
77. How to Use the Redo Function 
78. About the Quick Access Bar 

 

12 Excel Tips and Articles

Here are 12 Excel Tips and Learning Articles, from 599cd.com, that will help you 
learn the the following Excel functionality: VLOOKUP / HLOOKUP Functions, IF 
Function, Autosum Button, Sorting, Working with Dates and Times, String 
Concatenation, and a Button to Change Values. 

6 Excel Tips:
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Using VLOOKUP / HLOOKUP to find a value 
Using the IF function to calculate sales tax 
Dealing with ZIP codes that start with zero 
Autosum Button not always working 
Sorting Data in Excel  

6 Excel Learning Articles:

Excel: Separating Time & Date
Excel: Aged Accounts Receivable
Excel: Days Between Dates
Excel: String Concatenation
Excel: Button to Change Value
Excel VLOOKUP Function 

 

PowerPoint Tutorials from the University of California

Here are several excellent PowerPoint Training Tutorials from the University of 
California. These will show and teach you how to use many features of PowerPoint, 
as shown and linked to below. The first document is a comprehensive PowerPoint 
Guide with 9 screen video tutorials. This free training document will take you through 
practices and recommendations for creating and using PowerPoint 
presentations. This tutorial guide was created using PowerPoint XP and 2003, but 
many of the specific instructions are also applicable to version 2000. The remaining 
PowerPoint tutorials are available in several formats: .doc, .pdf, and video.

●     PowerPoint Guide 
❍     Introduction to the PowerPoint Guide (0.9mb)
❍     Creating a Blank PowerPoint Presentation (1.67mb)
❍     Inserting Text, Images, and New Slides (1.61mb)
❍     Inserting Tables and Graphs in Your PowerPoint Presentations 

(2.83mb)
❍     View Modes in PowerPoint (4.48mb)
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❍     Choose a Color Layout For Your PowerPoint Presentation (4.25 mb)
❍     Adding and Modifying Animations and Slide Transitions in Your 

PowerPoint Presentation (2.48 mb)
❍     Adding Speaker Notes to Your PowerPoint Presentation (2.14mb)
❍     Adding Media to Your PowerPoint Presentation (3.73 mb)

●     Creating an Image-Only Presentation (.doc, pdf, Video - 1.88mb) 
●     Manually Setting Animations and Slide Transitions in PowerPoint (.doc, pdf, 

Video - 0.4mb)
●     Effective Presentation Visuals in PowerPoint (.doc, pdf)
●     Combining PowerPoint Presentations (.doc, pdf, Video - 0.4mb)
●     Timing PowerPoint Presentations Manually (.doc, pdf, Video - 0.5mb)
●     Acceptable File Formats in PowerPoint for Windows (.doc, pdf)
●     Searching for Images (.doc, pdf, Video - 4.4mb)
●     Optimizing Images for PowerPoint and the Web (.doc, pdf)
●     Resizing Images in Photoshop (.doc, pdf)
●     Compressing Images in Powerpoint for: Mac (.doc, pdf) or PC (.doc, pdf, 

Video)
●     Batch Cropping of Images (.doc, pdf)
●     Cross-compatilibilty Issues Between Mac and PC Platforms (.doc, pdf)
●     Using the "Pack and Go" Tool in PowerPoint for Windows (.doc, pdf, Video - 

0.4mb)
●     Exporting PowerPoint Presentations onto CD or Other External Media for Mac 

(.doc, pdf)

●     Create a Slide Presentation using PowerPoint XP. Add objects, images, and 
text. Learn how to use animations to build slides. 

●     Intermediate PowerPoint, The Next Step (pdf). Support filess: non-linear.ppt 
and .avi file 

●     Tutorial in PowerPoint format 
●     Tips for teaching large classes

 

Inserting Video Into PowerPoint Presentations
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Here is a quick 2-page PowerPoint tutorial that explains How to Insert Video into 
your PowerPoint Presentation. It is provided by the Center for Educational 
Technology at Emory University, which provides informational software tutorials to 
assist faculty, students, and staff. To include video files in Powerpoint you must have 
them in a digital video file format. Although Powerpoint claims to support various dv 
formats, .avi files are the most reliable when playing on PCs. This 9-step PowerPoint 
tutorial is in pdf format and is 256kb in size. 

 

Tips and Articles for Microsoft Access

Here are several informative, free Access Tips, Techniques, and Articles for 
Beginning, Intermediate, and Advanced Microsoft Access users, from 599cd.com, 
which is a fee-based training site. These will help you learn how to use many 
important features and functions of Access so you can manage and present your 
data more efficiently. Some of these include: Parameter Queries, Forms Control, 
Calculated Query Fields, Time/Date Differences, Update Queries, Working with 
Relational Tables, Aggregate Queries, Using Two Combo Boxes, the DLookup 
Function, the IIF Function, and Many-to-Many Relationships.

Beginner Access Tips:
Creating a Parameter Query
String Concatenation
Different Form Controls for Gathering User Input 
Calculated Query Fields
Form Control Wizards Not Starting 

Intermediate Access Tips:
Number of Months Alive
Form Footer Totals
Time/Date Differences
Building an Update Query
Using a Relational Combo Box
Making Relational Tables
Getting Query Criteria from a Form
Creating an Aggregate Query
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Advanced Access Tips:
Using MsgBox and vbYes to Close a Form
Breaking Up Text Strings
Incrementing Your Own Counter
AfterUpdate Event
Two Combo Boxes
Using the DLOOKUP Function
Using the IIF Function
Prevent Duplicate Values on Multiple Fields
Resize a Form using VBA Code

Access Learning Articles:
Access Tip: MsgBox with vbYes
Access: Removing THE From Title Sorts
Access: Next Business Day
Access: Reading Outlook Calendar Data
Access: Recordset, File I/O Example
Access: Many-To-Many Relationships
Access: Checking a Sequence of Numbers
Access: Daylight Savings Time
Access: Recordsets & Inventory
Access: Calculate 2nd Monday in January 

 

Free Desktop Publishing Course

Here is Rai OpenCourseware's Desktop Publishing Training, that will teach you 
important publishing features and tasks of Word, PowerPoint, Pagemaker. These 
free desktop publishing training tutorials are well illustrated and provide step-by-step 
instructions for using these applications. They are also available here, here, here, 
and here. 

Desktop Publishing: An Introduction
 - Principles Of Layout And Design
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 - Grids And Columns Layout
 - Creating, Saving, Navigating And Viewing A Word Document
 - Working With Multiple Documents,Windows And Text
 - Correcting Spelling And Grammer, Using Theasurus And Symbols
 - File Management And Advanced Printing Options
 - Quiz
 - Assignment

Learning About Powerpoint
 - Identifying Toolbars
 - Creating Custom Design Templates
 - Creating Bulleted Lists
 - Drawing Objects
 - Using Images And Other "Clip Art"
 - Animating The Presentation-I
 - Animating The Presentation-II
 - Giving An On Screen Presentation
 - Introduction To Photoshop Interface
 - Earse Tools, Paint, Gradient,Transformation
 - House Styles- Styles Guide & Typeface
 - Styles Guide- Headlines & Fonts
 - Projects

Introduction To Pagemaker
 - Pagemaker Toolbox
 - Laying Out A Pagemaker Document
 - Working With Text
 - Working With Text Exercises
 - Working With Graphic Objects
 - Using The Story Editor
 - Working With Multiple Pages
 - Quiz
 - DTP- Quiz 

 

    

file:///C|/Data/newsletter51.html (17 of 34) [8/25/2008 10:32:05 PM]

http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-03.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-04.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-05.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-06.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-07.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-08.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-09.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-10.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-11.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-12.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-13.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-14.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-15.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-16.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-17.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-18.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-19.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-20.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-21.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-22.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-23.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-24.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-25.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-26.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-27.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-28.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-29.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-30.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-31.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-32.pdf
http://www.rocw.raifoundation.org/computing/BCA/desktoppublishing/lecture-notes/lecture-33.pdf


July 2008 Newsletter for EducationOnlineforComputers.com: Free Computer Software Training & Tutorials

 

3) The Best New Free Training Sites for Flash, Photoshop, 
Dreamweaver, FrontPage, and other Adobe and Macromedia 
Applications

Flash MX Tutorials and Lessons 

Here are some excellent Flash MX Tutorials and Lessons, hosted by the University 
of Tennessee of one of their web development courses. Most of the features 
demonstrated and taught by these tutorials are also applicable to later versions of 
Flash.

Flash MX Lessons
(2.0mb, unzips to Lessons folder)

In the Lessons folder, after unzipping lessons.zip, go to the Lessons folder to access 
the following Flash Lessons, in .swf format:
 - Getting Started with Flash
 - Illustrating in Flash
 - Adding and Editing Text
 - Creating and Editing Symbols
 - Understanding Layers
 - Creating Tweened Animation
 - Creating Buttons
 - For Director Users
 - For FreeHand and Illustrator Users
 - For Fireworks and Photoshop Users

Flash MX Tutorial
(3.7mb, unzips to pdf 4.3mb file, 90 pages)
Also, here are the Tutorial Files for this Flash Tutorial pdf document (11.3mb, unzips 
to Tutorials folder)

Chapter 1:
  Introduction to Flash MX Tutorial
  What you should know
  View the completed movie
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  Analyze the stiletto.fla file
  Define properties for a new document and create a gradient background
  Create and mask vector art
  Tween bitmap effects within a movie clip
  Load dynamic text at runtime
  Add animation and navigation to buttons
  Add streaming and event sounds
  Organize your Library panel
  Test download performance and publish the movie
  The next steps

Chapter 2:
  Introduction to ActionScript Tutorial
  View a completed movie
  Initialize the movie
  Save and retrieve information
  Display information in a dynamic text box
  Write an expression
  Control the flow of the movie
  Create commands and reuse code
  Use a built-in object
  Test the movie
  The next steps

Chapter 3:
  Introduction to Components Tutorial
  Types of components
  View the completed form
  Create a form
  The next steps 

 

8 Flash Tutorials from Newtutorials

Here are 8 well done, illustrated Adobe Flash Tutorials from newtutorials.com. These 
show and teach several Flash features that you should have in your Flash skills 
repertoire. Flash gives web designers the ability to bring together video, text, audio, 
and graphics into compelling and interactive experiences that communicate and 
impart knowledge more effectively.. 
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●     Cool Masking Effect
●     Flash Drop Down Menu
●     Flash Preloader Tutorial
●     Moving Lines Flash Tutorial
●     Mouse Follower: Part 1
●     Mouse Follwer: Part 2
●     Rotating Objects in Flash
●     Color Flashlight

 

12 Flash Tutorials from senocular.com

Here are 12 nice Flash Tutorials from senocular.com. These will show you how to 
use several Flash features, and also teach you how to script using Actionscript 3. 
Featrues demonstrated include the Drawing API, Button Events, Preloading, 
Transformation Matrix, Depths, the Color Object, Listeners and AsBroadcaster, and 
Date countdown.

●     Flash Player 10 Drawing API
●     Getting Started with ActionScript 3.0 in Adobe Flash CS3
●     Beginners Guide to Getting Started with AS3 (Without Learning Flex)
●     Dealing With Flash Button Event Capturing
●     Preloading in Flash
●     Understanding the Transformation Matrix in Flash 8
●     Using senocular.com's Ease Class
●     Depths in Flash MX
●     Understanding the Color Object
●     Listeners and AsBroadcaster
●     Date Countdown Timer
●     Flash Frequently Asked Questions (FAQ)
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Photoshop Tutorials from the University of California

Here are several well written Photoshop Training Tutorials from the University of 
California. These will show you how to use what the author considers the most 
useful and straight-forward Photoshop techniques for creating, preparing, and fixing 
images for web pages. They do not go into details about pixels, resolution, and color 
management. 

●      Optimizing Images for the Web and PowerPoint (.doc, pdf, video-5.6mb)
●      Batch Processing in Photoshop (with emphasis on Cropping) (.doc, pdf)
●      Resizing Images (.doc, pdf)
●      Saving Images in Different File Formats (.doc, pdf, video-4.9mb)
●      Saving Images for the Web (.doc, pdf)

Adobe Photoshop Tutorial  (9 pages, 1.26mb, pdf format)
Photoshop Elements Tutorial  (9 pages, 852kb, pdf format)

Contents for both of these tutorials:
  I. Introduction
  II. Finding images
  III. To start this tutorial
  IV. Important Help
  V. Preparing digital images for website posting
  VI. Adding text
  VII. Improving appearance of graphs and figures
  VIII. Final image format 

 

29 Photoshop Video Tutorials from graphicssoft.about.com

Here are 29 very good Photoshop Video Tutorials, from graphicssoft.about.com, that 
will teach you several important tools and techniques in Adobe Photoshop. 
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Using these videos, you'll learn Photoshop features and tools for editing and 
touching up your photos, designing original art work, and creating a variety of 
effects. A written transcript of each Photoshop tutorial is also available for offline 
learning.

●     Wrap Text Effect in Photoshop - Video 
●     Use the Pattern Stamp Tool in Adobe Photoshop - Video 
●     Remove Photography Grain or Noise in Adobe Photoshop - Video 
●     How to Create a Rainbow in Adobe Photoshop - Video 
●     Convert Color Photos to Black and White with Photoshop - Video 
●     How to Add a Text Watermark in Adobe Photoshop - Video 
●     Adobe Photoshop Sand Effect - Video Tutorial 
●     Adobe Photoshop Text Reflection - Video Tutorial 
●     Adobe Photoshop Photo Frame - Video 
●     Adobe Photoshop Fire Text Effect 
●     Adobe Photoshop Brightening a Photo 
●     Make a Skewed Picture Straight in Adobe Photoshop 
●     Fix Picture Imperfections with Adobe Photoshop Healing Brush 
●     Fix Picture Imperfections with Adobe Photoshop Clone Tool 
●     Adobe Photoshop Web Button 
●     Adobe Photoshop Shortcuts 
●     Adobe Photoshop Sepia Effect 
●     Adobe Photoshop Red Eye Fix 
●     Adobe Photoshop Pet Eye Fix 
●     Adobe Photoshop Photo Filter 
●     Adobe Photoshop Pattern Maker 
●     Adobe Photoshop Patch Tool 
●     Adobe Photoshop Marquee Tool Background 
●     Adobe Photoshop Magic Eraser Tool 
●     Adobe Photoshop Lighting Filter 
●     Adobe Photoshop Layers 
●     Adobe Photoshop Ice Effect 
●     Adobe Photoshop Dodge Tool Brightening 
●     Turning Pictures into a Coloring Book with Photoshop 
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Dreamweaver Tutorials from the University of California

Using Dreamweaver, you can create, view, and organize an entire web site. 
Although it is possible to start constructing a web site by composing individual 
pages, it is best to define and set up the general site structure ahead of time. Here 
are several excellent Dreamweaver Training Tutorials from the University of 
California. These will show and teach you how to use Dreamweaver's features to set-
up and create a web site, along with preparing images for it.

●     Dreamweaver Guide: Pointer and Tips (.doc, pdf)
●     Creating Links in an Existing Document (.doc, pdf)
●     Creating Non-English Webpages (.doc, pdf)
●     Optimizing Images for the Web (.doc, pdf)
●     Resizing Images for the Web (.doc, pdf)
●     Batch Cropping Images Using Photoshop (.doc, pdf)
●     Saving Images in Different File Formats (.doc, pdf, Video - 4.9mb)
●     Saving for the Web (.doc, pdf)

Dreamweaver Tutorial
This 38-page, 5-part tutorial guides you through the process of creating a web site 
with Dreamweaver MX 2004. (38 pages, 2.9mb, pdf format) 

    

4) The Best New Free Web Development Training Sites

Web Design Articles and Tutorials from Wpdfd.com

Wpdfd.com, Webpage Design for Designers, provides some of the best written Web 
Design Articles and Tutorials on the web today. Here are all of their web 
development topics, in  alphabetical order. These cover many areas of web design 
and development, take a look at the linked list below to find what you are looking to 
learn more about. 
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Free Internet and Website Management Course

Rai OpenCourseware offers freely available course content, or courseware, which is 
literally a "treasure trove of knowledge and related resources".  Their Computing 
Courses provide higher education and learning for Information Technology to all 
students and professionals who like to study and learn on their own. Educational 
institutions can also use this free course content.

Here is Rai OpenCourseware's Internet and Website Management Course, that will 
teach and show you how to use many Internet and Web development technologies, 
including HTML, Java, Java Servlets, Cookies, DHTML, CSS, VBScript, JavaScript, 
Perl, XML, software configuration, and website management. These free website 
application development training tutorial lessons are well illustrated and provide step-
by-step instructions for using the Internet technologies and web programming tools 
and languages being taught. The course tutorials are in pdf format. 

 

Free Internet Technologies Course

Here is the Internet Technologies Course from Rai OpenCourseware. The tutorials 
and lessons in this course review and cover serveral important Internet and Web 
development technologies, including networking and internetworking, OSI, TCP-IP, 
Internet Hubs and Bridges, Internet Routers, HTML, Java, Java AWT, Java Servlets, 
DHTML, and VB Script. These free Internet and Web training lessons are well 
illustrated and provide step-by-step instructions. The course tutorial lessons are in 
pdf format. 
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2 Web Design and Development Training Guides

Here are two Web Design and Development Learning Guides hosted by the 
University of California. The first is a nice 73-page guide covering web design and 
usability. The second one is a 3-part HTML basics tutorial that will help you get 
started with developing a web site.

Web Design and Usability Guidelines
This 73-page pdf document is an excellent comprehensive Web Design Guide that 
will help you accurately design your website. (2.35mb)

 - Design Process
 - Design Considerations
 - Content and Content Organization
 - Titles and Headings
 - Page Length
 - Page Layout
 - Font and Text Size
 - Reading and Scanning
 - Links
 - Graphics
 - Search
 - Navigation
 - Software and Hardware
 - Accessibility

Elementary HTML Tutorial - Part 1
Elementary HTML Tutorial - Part 2
Elementary HTML Tutorial - Part 3
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5) The Best New Free Windows, Linux, Hardware and 
General Computer Training Sites 

Windows XP Tricks, Tips, and Tweaks

These tutorials from tutorial-net.blogspot.com will help you use Windows XP more 
effectively. Also take a look at their other page giving you more Windows XP Help 
and Tips. 

 

Course Lectures for "Inside the PC"

PC Architecture:  | Lecture 1  | Lecture 2  | Lecture 3  | Lecture 4  | Lecture 5 
 | Lecture 6 

Motherboards, CUPs, and RAM:  Lecture 8  | Lecture 9  | Lecture 10  | Lecture 11 
 | Lecture 12 

Disk Drive Storage: | Lecture 13  | Lecture 14  | Lecture 15  | Lecture 16  | Lecture 17 
 | Lecture 18 

Printers: | Lecture 19  | Lecture 20  | Lecture 21  | Lecture 22  | Lecture 23 
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3 Windows XP eBooks

Here are 3 Windows XP ebooks you can download. To access this site, yyou may 
need to click on yes to a security setting popup.

Windows XP and Office 2003 Keyboard Shortcuts eBook
(Windows help format - chm)

Windows XP Registry Guide eBook
(pdf format)

Configuring and Troubleshooting Windows XP Professional
(pdf format) 

 

Getting Started with Windows XP Professional 

This manual is designed to provide you with a basic overview of the Windows XP 
Professional operating system. It provides valuable lessons in file management, 
navigation, shortcuts, and overal functionality.   (pdf format, 883kb)

 

 

6) Software, Office and Computer Sites and Downloads 
Worth Mentioning 

The following programs are totally Free, no popups, no adware, no spyware, 
and no shareware.
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Harddisk Search and Stats

Harddisk Search and Stats is a file and disk search engine for your PC, that scans 
your drives or folders for files that contain one or more specified keywords. It then 
presents you with a list of files found, as well as statistics for keyword occurrence in 
each file and more. You can open the file and the built-in viewer can jump directly to 
the first location of the keyword. Features include recursive searches, file extension 
filters, wildcard support. 

 

GeoHTML

Create interactive image maps with GeoHTML. This program has more features 
than most other image mappers out there. It comes with HTML source view, real 
time preview, and a large selection of attributes that can be assigned to the selected 
areas. 

 

AscToTab

AscToTab converts plain or tab-delimited text tables into HTML or RTF tables. For 
plain text files AscToTab will attempt to automatically determine how many columns 
the table has, determine the default alignment of each column, which rows are 
header rows, spot entries that span several columns, spot entries that span several 
rows. You can specify th BORDER, WIDTH, CELLPADDING and CELLSPACING 
attributes as well as several other HTML properties. In addition, you can output to 
RTF, process tab-delimited files and color odd and even rows of the table differently. 
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MovieSnapshot

MovieSnapshot allows you to easily grab a frame from a video file and save it as 
JPEG image. Just drag and drop any movie file onto the MovieSnapshot interface, 
select the frame to grab and click the save button. The program supports all installed 
DirectShow video and audio codecs. 

 

ScrollBar

ScrollBar is a tool for web designers, allows you to generate CSS code to colorize 
the scrollbar in Internet Explorer. It comes with several color schemes included, that 
can be customized to match your design, or you create schemes from scratch and 
save them for later. It comes with a built-in color picker to pick a color from anywhere 
on your screen, a real-time preview that allows you view the scrollbar, as well as an 
additional background and sample text. The complete code can be copied to the 
clipboard, to be inserted into your web page. 

 

DupKiller

DupKiller helps you find duplicate files on your computer, that may be scattered 
across multiple folders or hard drives. It scans all selected drives, and presents you 
with a list of duplicates, organized in individual groups, and you can decide which 
files to delete. The standard scan process which considers the file size, date and 
name for a match is very fast and will accurately detect most duplicate files. For 
increased accuracy, you can choose content matching, which will take longer but is 
highly reliable since it compares duplicate files byte by byte.
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7) Question of the Month about Software Training: 

Each month Scott Turton will answer a current or important question that we 
have received about computer and software training.

July 2008 Question of the Month:  

What are some of the "best of the best" freeware software applications available on 
the web today?

Answer: 

Scott Dunn over at Windowssecrets.com has reviewed and writes about the 
software apps that were rated as the best freeware by four other sites: 25 Free 
Downloads You Need Now from Computer Shopper, 101 Fantastic Freebies from 
PC World, The Best Free Software from PC Magazine, and the 46 Best-ever 
Freeware Utilities from Tech Support Alert. He compares these lists and finds that 
there are nine applications that were endorsed by at three or more of these software 
reviews. Here they are:

 Avira AntiVir Personal - Anti-virus scanning in real time, incuding rootkits.

Comodo Firewall Pro - More tough and robust that the firewalls that come with 
Windows XP or Vista.

TrueCrypt - Allows you to encrypted your files in Windows Explorer and other file 
managers.

CCleaner -  Cleans your drives by deleting unneeded temp files, cookies, browsing 
history, recent-document lists, log files, etc.

Lightning for Thunderbird - color="black"> size="2"> face="Arial,Sans-serif">A 
calendar and to-do list plug-in for Thunderbird Email from Mozilla. 

Foxit Reader - Firefox add-in for viewing, printing, and annotating PDF documents.
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Audacity - A great audio editor that supports .mp3, .wav, and other popular audio 
formats.

Wavosaur - Another fine audio editor that supports many popular audio formats.

Pidgin - Allows you to IM your friends and co-workers using AIM, Yahoo, Windows 
Live Messenger, and 12 other chat networks.

I hope this helps you.

Scott Turton
Site Editor
EducationOnlineForComputers.com 

8) Please Support Our Training Mission

http://www.EducationOnlineForComputers.com 

How You Can Support Our Computer and Software Training Mission 

Please help support EducationOnlineForComputers.com's Computer and Sofware 
Education and Training Mission by visiting our sponsors below and requesting more 
information. By doing so, you will be helping people who want to learn to use 
computers in an Information Technology career. 

 

EdComp.com:
www.edcomp.com/
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This is our new free computer and IT education and training search engine housing 
over 150,000 free training internet resources! Just type in a topic you're looking for 
and get tons of great web resources instantly. These search results are much better 
than the big search engines, like google. You can also check out our predefined 
search results page giving you tons of free training resources: 
http://www.edcomp.com/predefined.htm. 

 

ITT Technical Institute: Choose from their many programs

University of Phoenix Online: Advance your career  

DeVry: Online degrees for working adults 

 

EducationOnlineForComputers.com
www.educationonlineforcomputers.com 

Free Computer Software Training Now!

A free and member-based software educational and training portal web site. We 
have compiled, categorized, described, and linked many sites that will be of keen 
interest to computer software application end-users seeking free training and 
knowledge. Many subject areas are covered, including Microsoft Office, Flash, 
Photoshop, Dreamwever, FrontPage, Web Development, Windows, Linux, and 
Computer Hardware. You are able to study and learn all about computer software 
via Free training, courses, tutorials, documentation, articles, tips, notes, and help. 
Check us out today. 
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Copyright Notice: Please note that all of the items hyperlinked are copyrighted by 
their authors and/or publishers. You are expected to look for, read, and adhere to 
such notices. Downloaded and online material is copyrighted whether or not a 
copyright notice is present.

  

***EducationOnlineForComputers.com's Member Site *** 

Our Members' Site contains the web's best computer software training resources 
and tutorials. This content is individually linked and presented in a way to expedite 
and facilitate your software and computer learning experience. We have done all the 
web research and presentation work for you so you can concentrate solely on your 
computer training.

EducationOnlineForComputers.com Member Site FAQ Answers: 

1.  All of the web sites and pages in our members site are not in the free section 
of our web site. The member site training is more detailed and the best 
available. The online training resources in our members' site are linked and 
laid out in a much more detailed fashion than those in the free section. This 
will save you time in finding all the best free training on the web.

2.  You can choose to pay using either Paypal or 2Checkout. If paying pay check 
and you live in the U.S., please select 2Checkout.

3.  You have a choice to select the non-recurring or recurring method of payment. 
If you select non-recurring, when your membership period expires, you will not 
be automatically charged another fee on your credit card or check.

4.  The total price to join our member's site is only $14 total for 2 months, $24 for 
4 months, $32 for 6 months, or $56 for a whole year. The funds generated will 
assist us to help all those seeking software application education training. 
Here's the link to see what's available on our member's site and to sign up: 
http://tinyurl.com/7ien You can email Scott Turton with questions at 
scott_turton@educationonlineforcomputers.com 

I will give you 5 Great Free Bonuses when you sign up now. 

These are as follows: 
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1.  28 Modules of Soft Skills Training, covering topics such as Coaching, 
Delegating, Finance Essentials, Hiring, Leading and Motivating Team, Making 
a Presentation, Managing Your Time, and Setting Goals. 

2.  19 Online Business and Reference Books, including titles such as Scientific 
Advertising, The Art of Electronic Publishing, and Small Business Manual 

3.  12 Instructive e-Books, including On Line Stealth Marketing, 7 Secrets to 
Unlimited Traffic, and Increase Auction Profits. 

4.  Instant and Easy Online Access to the 24 Best Free Computer Help & Support 
Sites. 

5.  45 of the Best, Completely Free Programs and Utilities.

To Subscribe to this Free monthly Newsletter of Computer Education, 
Training, & Tutorial Resources simply:

Go to this web page and use the subscribe form:  
http://www.educationonlineforcomputers.com/newsletr_sub_unsub.html

  

Thank You!
scott_turton@educationonlineforcomputers.com   
http://www.EducationOnlineForComputers.com 
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